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Abstract

These Application Notes describe the procedures for configuring Bell Canada Session
Initiation Protocol (SIP) Trunking with Avaya IP Office Release 9.1.

Bell Canada SIP Trunking provides PSTN access via a SIP trunk between the enterprise and
the Bell Canada network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Bell Canada is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Bell Canada and IP Office solution. In the sample configuration,
IP Office solution consists of an IP Office 500v2 Release 9.1, Avaya Voicemail Pro, IP Office
Softphone, and Avaya H.323, SIP, digital, and analog endpoints.

The Bell Canada SIP Trunking service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calling via standards-based
SIP trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

The Bell Canada SIP Trunking service uses Digest Authentication for outbound calls from the
enterprise, using challenge-response authentication for each call to the Bell Canada network based
on a configured user name and password (provided by Bell Canada and configured in IP Office).
This call authentication scheme as specified in SIP RFC 3261 provides security and integrity
protection for SIP signaling.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using IP Office to connect to
Bell Canada SIP Trunking service. This configuration (shown in Figure 1) was used to exercise the
features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with IP Office was connected to Bell Canada SIP Trunking service. To
verify SIP trunking interoperability, the following features and functionality were exercised during
the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the IP Office Softphone.

¢ Inbound and outbound long holding time call stability.
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e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711MU and G.729A.

e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

e Telephony features such as hold and resume, transfer, and conference.

e Use of SIP REFER for call transfer to PSTN.

e Fax G.711 Pass Through mode.

e Off-net call forwarding.

e Twinning to mobile phones on inbound calls.

2.2. Test Results
Bell Canada SIP Trunking passed compliance testing.

Items not supported or not tested included the following:
e Inbound toll-free is supported but was not tested as part of the compliance test.
e T.38 Fax is not supported.
e Call redirection (Blind/Consultative transfer) using REFER is not supported. See observation
below.

Interoperability testing of Bell Canada SIP Trunking was completed with successful results for all
test cases with the exception of the observations/limitations described below.
e Call Redirection Off Net Blind Transfer Using REFER method — When using REFER

method for off net blind call transfer from PSTN1 to PSTNZ2, Bell responds 202 Accepted to
IP Office’s REFER message then returns 408 Request Timeout right after. According to Bell
SIP trunk specification, Bell SIP trunk does not support REPLACE in the IP Office’s Refer-
To header. User will experience no ringback tone on PSTN1 and sometimes there is no
speech path between PSTN1 and PSTN2. Due to this issue, the recommended setting on IP
Office would be set to never use REFER method for call transfer but rather use re-INVITE.
This setting is reflected on the IP Office SIP line setting in section 5.4.2.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Bell Canada SIP Trunking, contact Bell Canada at
http://www.bell.ca/enterprise/EntPrd_SIP_Trunking.page.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Bell Canada SIP Trunking service through the public IP network. For confidentiality
and privacy purposes, actual public IP addresses used in this testing have been masked out and
replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an IP Office 500v2 with the MOD DGTL STA16 expansion which
provides connections for 16 digital stations to the PSTN, the extension PHONE 8 card which
provides connections for 8 analog stations to the PSTN as well as 64-channel VCM (Voice
Compression Module) for supporting VolP codecs. The LAN port of IP Office is connected to the
enterprise LAN while the WAN port is connected to the public IP network. Endpoints include an
Avaya 9600 Series IP Telephone (with H.323 firmware), an Avaya 9508 Digital Telephone, an
Avaya Symphony 2000 Analog Telephone and IP Office Softphone. A separate Windows XP PC
runs IP Office Manager to configure and administer IP Office.

Mobility Twinning is configured for some IP Office users so that calls to these user phones will also
ring and can be answered at the configured mobile phones.

BEI
SIP Trunking Services

192.168.195.200

SIP/
UDP |
§

WAN
Avaya Voicemail Pro
| for IP Office
. s Avaya 11x0 SIP 10.10.98.86
S Avaya Communicator ~ Avaya 9600-Series
AvayIP Office 10.10.93.11 e ‘i.’mdows H.323IP Telephone IP Telephone
o
&
10.10.97.39
‘@ _Enterprise LAN Enterprise LAN ()

Digital Phone Analog
Phone / Fax

Figure 1: Test Configuration for IP Office with Bell Canada SIP Trunking Service
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For the purposes of the compliance test, IP Office users dialed a short code of 9 + N digits to send
digits across the SIP trunk to Bell Canada. The short code of 9 was stripped off by IP Office but the
remaining N digits were sent unaltered to Bell Canada. For calls within the North American
Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP calls, IP
Office would send 11 digits in the Request URI and the To field of an outbound SIP INVITE
message. It was configured to send 10 digits in the From field. For inbound calls, Bell Canada SIP
Trunking sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.

Bell Canada uses the phone number in the From header of a SIP INVITE message to authenticate the
calling party. Thus, a call will be rejected by the network unless the From header contains a number
known to Bell Canada. This is especially important for calls inbound from the PSTN which are
redirected back to the PSTN by call forwarding or twinning. For call forwarding, IP Office sends the
number of the forwarding phone in the From header. This is a number known to Bell Canada. As a
result, the call display on the destination phone shows the forwarding party not the original caller.
For twinning, this behavior can be slightly altered through configuration. See Sections 5.3 and 5.4
for details.

Note that the calling party authentication using the phone number by Bell Canada, as mentioned
above, is in addition to the Digest Authentication by Bell Canada during call setup SIP signaling
exchanges using a user name and password as configured in IP Office for all calls from the
enterprise to Bell Canada.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment/Software

Release/Version

Avaya IP Office 500 V2 9.1.300.120
Avaya IP Office Manager 9.1.300.120
Avaya Voicemail Pro for IP Office 9.1.300.120

Avaya 11x0 IP Telephone (SIP)

SIP11x0e04.03.12.00

Avaya 9630G IP Telephone (H.323)

Avaya one-X® Deskphone Edition S3.2

Avaya Communicator for Windows 2.0.3.30
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A

Bell Canada SIP Trunking Service Components

Equipment/Software

Release/Version

Oracle ACME Packet Net-Net 4500 SC 7.2.0 MR-5
BroadSoft Broadworks r.20
Legacy Nortel CS2K Media Gateway CVM17

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone 1P
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without

T.38 Fax Service.
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5. Configure IP Office

This section describes IP Office configuration to support connectivity to Bell Canada SIP Trunking
service. IP Office is configured through IP Office Manager PC application. From a PC running IP
Office Manager application, select Start - Programs - IP Office > Manager to launch the
application. Navigate to File > Open Configuration, select the proper IP Office system from the
pop-up window, and log in with the appropriate credentials. A management window will appear
similar to the one shown in the next section. The appearance of the IP Office Manager can be
customized using the View menu. In the screens presented in this section, the View menu was
configured to show the Navigation pane on the left side, the Group pane in the center, and the
Details pane on the right side. These panes will be referenced throughout IP Office configuration.
Proper licensing as well as standard feature configurations that are not directly related to the
interface with the service provider (such as LAN interface to the enterprise site and IP Office
Softphone support) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the DevCon IPO2 was used as the system name and the WAN port was

used to connect IP Office to the public network. The LAN1 settings correspond to the WAN port on
IP Office.

To access the LAN settings, first navigate to System (1) - DevCon IPO?2 in the Navigation and
Group Panes and then navigate to the LAN2 - LAN Settings tab in the Details Pane.

e Set the IP Address field to the IP address assigned to the IP Office WAN port.

e Setthe IP Mask field to the mask used on the public network.

e All other parameters should be set according to customer requirements.

[ ]

Click OK.
IPOffices |  System || DevCon IPO 2* = v
& BOOTP 9) Narme

4% Operator (3
-2 DevConIPO 2
-5 System (1)
..... 5 Line (10)

----- “2 Control Unit (4) IP Address 0 . 10 . 9% . 13
----- 4 Extension (42)

----- § Userpay IP Mask 255 . 255 . 255 . 224
..... 2% Group ()
----- 8% Short Code (56) Primary Trans. IP Address 0 0 0 0

Twinning | VM | Codecs | VoIP Security | Contact Center|
System | LANL || LAMNZ || DNS | WVoicemail | Telephony | Directory Services | System Events | SMTP | SMDR |

LAN Settings |I‘u’oIP | Metwork Topology|
1

..... % RAS (1) Firewall Profile I<None> v‘
----- Incoming Call Route
..... £ WAN Port (0) RIP Mode INone v‘

..... 2 ot [] Enable NAT
-1 Time Profile (0)

""" @ Firewall Profile (1) Mumber Of DHCP IP Addresses |1 2
----- W 1P Route (2)

..... &m Account Code (0) DHCP Mode

""" e License (42) ©) Server () Client © Dialin @ Disabled l
""" & Tunnel (0)

----- §5 UserRights (8)

B8 o putendent ) [T e ) [ ip

Advanced ‘
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Select the Vol P tab as shown in the following screen.
e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones
using the H.323 protocol, such the 9600-Series IP Telephones used in the sample
configuration.
e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to
Bell Canada.
e The SIP Registrar Enable box is checked to allow IP Office Softphone usage.
e The Layer 4 Protocol, check the UDP box and set UDP Port to 5060.
e All other parameters should be set according to customer requirements.

e Click OK.
POffices  System |7 DevCon IPO 2* v

R B00OTP )

Control Unt [4)
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§ Userid)
& Group (7)
X Short Code (66)
@ Service )
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@ Incoming Caft Route
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= Directory D)

. Tune Profde )
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BB 1P Route 2)
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‘ 4 User Rights 8)
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€ ARS2)
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|RTP
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J TS TiSPort 5061
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RTP
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-
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port is set to 5060.

e All other parameters should be set according to customer requirements.

e Click OK.

IPOfices | System |7 DevCon IPO 2* v
300TP (9) L\ = -
R eoarr @) lig‘:] Codecs | Vol Security | Contsct Center
[ DevCon IPO 2 0o POZH Loaten [ LA DHS | Voicemail | Teleghory | Directory Services | System Events | SMTP | SMDR | Twinning | vem
LAN Settings | Vel | |[Network Topology
Control Unit (§) Network Topology Discovery
i 3
@ Extension 12) STUN Server Address 10101010 STUN Port #78
§ Use
i .;-m..;;f 7 Firewall/NAT Type | Open Internet Y.
9% Shart Code (66)
o Service f0) Binding Refresh Time (seconds) &0
& PAS{1
@ Incoming Cali Route Public 1P Address 104 10 98 113 Run STUN
@ WAN Port (0)
“u Dwectory (0) Public Port
Time Pralile D)
@ Firewall Profile (1) uopP 060
W P Route (2) .
&m Account Code {0) TP 5060
W License (42) = 061
& Tunnel 0) TLS e
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5 Location @
28 Authorization Code ( -
' 0K Cancel Help

In the compliance test, the LAN1 interface was used to connect IP Office to the enterprise site IP
network. The LANL1 interface configuration is not directly relevant to the interface with Bell Canada
SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings
Navigate to the Telephony - Telephony Tab in the Details Pane.

e Choose the Companding Law typical for the enterprise location. For North America, ULAW

IS used.
e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.

e Click OK.
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ok 4 Analogus Beensans Companang Law
x
- h
Detmtt Outsete Call Segquance Mermed -
g 1
: Defwatt bvicte Cal Suz Hg Typed - & U-taw ® U-taniine
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affects twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party

information for Mobile Twinning box on the System = Twinning tab. The second parameter is
the Send Caller ID parameter on the SIP Line form (shown in Section 5.4).
e For the compliance testing, the Send original calling party information for Mobile
Twinning as shown below was unchecked. This setting allows Send Caller 1D parameter
that was set to P Asserted ID in Section 5.4.2 to be used.

e Click OK.
IPOffices | System [[:= DevCon IPO 2 ey v
o BOOW o fama 1 vem | Codecs | VolP Security ] Contact Center |

LANZ I DNS ] Voicemail | Telephony l Directory Services | System Events | SMTP I SMDR ‘ _'l’f_"!”""_u_‘

i~ Operator (3 W DevCon IPO 2 |
[ DevCon P02 ———_——J | System | LANI
Y System (1

‘[ || Send original calling party information for Mobile Twinning

T4 Line (10)
Contral Unit (4)
& Extension (42)

f User (44)
W Group (7) | ‘ Help
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Calling party information for
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Bell Canada SIP
Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New - SIP Line, then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF_Bell Canada_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.

%" IP Office Manager Preferences l. ? l&]

| Preferences l Directories | Discovery |; Visual Preferences | Security i Validation |

Icon Size [Small -

[¥] Multiline Tabs

[¥] Enable Template Opticns

[¥] Enable Template Creation

i) OK ‘ ‘ Cancel ’ ’ Help
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3. Import the template into IP Office Manager.
From IP Office Manager, select Tools - Import Templates in Manager. This action will
copy the template file into the IP Office template directory and make the template available
in the IP Office Manager pull-down menus in Step 5. The default template location is
C:\Program Files\Avaya\lP Office\Manager\Templates.

E Avaya IP Office Manager DevCon IPO 2 [9.1.300.120] [Administrator{Administrator)]
File Edit View | Tools | Help
. R ) g @ Extension Renumber...
DevCon IPO 2 1 Line Renumber... a;
Ceonnect To... —
IP Offic Z
i Export 4 o —
1 K BOOTP (9) SCN Service User Management SIP Line iTransportlSIP URIIVOIP
47 Operator (3)
=%y DevConIPO 2 Busy on Held Validation Line Number
%2y System (1) ) _
-7 Line (10) MSN Cenfiguration ITSP Domain Name
<2 Control Unit Print Button Labels
-4 Extension (4 - URI Type
; i User (44) Import Templat_eim Manage_r‘~~_

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices Line =
& BOOTP (9 Line Number  Line Type ||| SIP Line |Transport|SIP URI|VelP | T38
4 Operator (3] ] PRI 24 (Uni
= F“‘“LD“E:“Q T Mew > Line Mumber
""" % |15] Mew SIP Trunk from Template ITSP Demain Mame
_____ oy O
_____ & b [ Create SIP Trunk Template URI Type
..... U
..... ;ﬂ G L S Ll Location
_____ 2 St EE] Copy Ctrl+C
..... B s Paste Ctri+V
..... o R -
_____ @ In 75 Delete Ctrl+Del Prefix
..... Eﬂ w o Validate
..... :_‘n: o Connect To... Ctrl+T Mational Prefix
""" Ll T -
----- @ Fi R =l ) International Prefix
----- EA 1 Export as Template (Binary)
----- = A Country Cod
..... - L Show In Groups ountry -ode
..... i Mame Priori
_____ fz Custemize Columns... B
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 12 of 28

SPOC 9/22/2015 ©2015 Avaya Inc. All Rights Reserved. BCSIPTIPO913



5. In the subsequent Template Type Selection pop-up window, check Display All box. From
the Service Provider pull-down menu and the file name AF_Bell Canada_SIPTrunk.xml

created in Step 1. Click Create new SIP Trunk to finish creating the trunk.

" Template Type Selection e e S
Locale United States (US Endglish
Service Provider | AF_Bell Canada_SIPTrunk vl (] Display All

‘ Create new SIP Trunk ] ‘ Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line. On the SIP Line tab in the Details Pane, configure the
parameters as shown below:

Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of SIP URI in SIP headers such as the From header.

Set Send Caller ID to P Asserted ID Header.

Check the In Service box.

Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

Incoming Supervised REFER was set to Never as Bell does not support REFER method
the way IP Office does.

Outgoing Supervised REFER was set to Never as Bell does not support REFER method
the way IP Office does.

Other parameters are set as default values.

Click OK.

= Opesaton 3) -1
PO 2

IPOfices | Line |7 SIP Line - Line 18" &3 X v

R s007P W) Lane Mur [';U' .m% Transport | 9P US| VelP | T35 Fas!SIP Credentials SIP Advanced |Engineering

19 I Servic v

Vendor? lab internetooo. ca Check O0S

@ - Session Tamers

Choud vl  Fefresh Method Auto -
Tirrwe (seconds On Dernund
Forwarding snd Twinning
Nationa! Prefix "“*'_7?‘7""7'"""""
y Send Caller ID P Asserted ID i v
Intemational Prefu
Country Code Redrect snd Transfer
Nome Priority System Defauh = Inceening Supenssed SEFER Never -
. Ourgoing Supernsed REFER MNever -
Uescnption = -
Senda I Moved Temporety
Outgeing Bind REFER
'
}
oK | Soncel Help
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Select the Transport tab and enter the following information.

e The ITSP Proxy Address is set to the provided IP Address of Bell SIP trunk.

e Layer 4 Protocol is set to UDP.
e Send Port is set to the port number of IP Office, 5060.

e Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with

the parameters in the System - LAN2 - Network Topology tab.
e Other parameters retain default values in the screen below.
e Click OK.

IP Offices | Line |7 SIP Line - Line 19* T EEIEIIEEE
-~ R BOOTP 8 | Line Numbef | [gp |jne| Transport ki URI|VelP |38 Fax|SIP Credentials|SP Advanced|Enginesring
¢ Operator (3) | g1 =
DevConIPO 2 g | ITSP Prowy Address  192.168.195.200 |
hJ : ;17
1L 0 ) .
_____ T CIQ:t(ril)Un w18 MNetwork Configuration
""" 4 Extension (¢ Layer 4 Protocol [UDP V] Send Port 5060 =
----- ﬁ User (44) o, 20
----- ﬁ Group (7) w71 Use Metwork Topology Info ’LAN 2 VI 5060 =
----- % Short Code
- 27
""" B service ) Explicit DNS Server(s) 0 0 0 0 0 0 0 0
..... o RAS (1) 23
----- Incoming (| ™24 Calls Route via Registrar [V
@ g¢|™ 9
----- EB WAN Port ( A
£ Time Profil .
_____ @ Fil:g\zallr;rlc Separate Registrar i
----- El IF Route (2
----- Bl Account Co — oK ] ’ LCancel ] ’ Help
----- W |icence (47 J k
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A SIP Credentials entry must be created for Digest Authentication used by Bell Canada SIP trunking
service to authenticate calls from the enterprise to the PSTN. To create a SIP Credentials entry, first
select the SIP Credentials tab. Click the Add button and the New Channel area will appear at the
bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. In the bottom of the screen, the Edit Channel area will be opened. In the example screen
below, a previously configured entry is edited. The entry was created with the parameters shown
below:

provider.

Set User name, Authentication Name and Contact to the value provided by the service

Set Password and Confirmed Password to the value provided by the service provider.
The Expiry (mins) is set to 60.
Uncheck the Registration required option. Bell Canada does not require registration for

Digest Authentication.

Click OK.

IP Offices |

Line

T SIP Line - Line 19* e -

~® BOOTP (9)

Operator (3)
=} DevConIPO 2

..KEy erm (1
-+ Control Unit
----- 4 Extension (42
----- £ Useria

..... u Group (7)

----- @ Short Code (¢
----- @ service (0)

..... @ RAS (‘1]

----- @ Incoming Ca
----- ¥8 WAN Port (0)
----- == Directory (0)
7 Time Profile |
----- @ Firewall Profi
----- EA 1P Route (2)
----- @ Account Cod
----- e License (42)
""" @ Tunnel (0)
ﬁ 3 User Rights (£
----- i Auto Attendz

..... H Location [(1)]
----- m Authorizatior

Line Numb
a1
2
17
18
20
il
22
23
24

|SIP LinelTransportlSIP URIlVoIP |T38 Fax| SIP Credentials |SIP AdvancedlEngineering|

Index UserName Authentication Mame Contact Add... i

1 VEMD7_613:X}5500 (1A VEND7_613XX¥6509 014 VEMDT_613XXX6500 01A 60

Expiry (mins) Register

False
Remove

Edit SIP Credentials

User name VEND7_613XXX6509_01A

Authentication Name VENDT_613x¥8509 01A

Contact VEND7_613XX¥6509_01A

Password ITIYTYTIYTT)

Confirm Password LTI T

Expiry (mins) 60 =

(|

Registration required
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A SIP URI entry must be created to match each incoming number that IP Office will accept on this
line. Select the SIP URI tab, click the Add button and then New Channel area will appear at the
bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. In the example screen below, a previously configured entry is edited. For the compliance
test, a single SIP URI entry was created that matched any DID number assigned to an IP Office user.
The entry was created with the parameters shown below:

e Via field is pre-populated by IP Office.

e Set Local URI, Contact and Display Name to Internal Data. This setting allows calls on
this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

e PAI field is set to None.

e For Registration, select the account credentials previously configured on the line's SIP
Credentials tab.

e Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 19 was defined that only contains this line (line 19).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK.

IP Offices ‘ Line i SIP Line - Line 19* - K| v < |
& BOOTP (9) Line Number { |Spp ine| Transport| SIP URI|ViolP | 738 Fax|SIP Credentials|SIP Advanced| Engineering
i Operator (3) 1 i

...

% DevConIPO 2

-4 Line (10)
= Control Unit | ™18
----- 4> Extension (42 Edit...
----- ﬁ User (44) e, 20
..... .ﬂ Group (7) w2l
----- 8% Short Code (¢
----- B Service ()

..... Ngi RAS (1) ;23
----- @ Incoming Ca | ™24
----- $8 WAN Port (0)

Channel Groups Via Lecal URI Contact Display Name PAI  Credential Add...

2
~17 1 19 19 10.10.98113 Mene 1: VEND7_613X
2 19 19 101098113 613XKX6516 Nene 1:VEND7 613Ky | emove

----- a5 Directory (0)
£ Time Profile |
..... @ Firewall Profi

Edit Channel

----- Hl 1P Route (2) oK =
..... = Accgznet Cod Via 101098113 - 3
; -ll_—i::::((éz) Local URI Use Internal Data - Eancel
@3 User Rights (£ -
_____ i Auto Attend: Contact Use Internal Data
----- "¢ ARS (2) Display Mame Use Internal Data -
""" i@ Location (0)
----- ‘m Autherizatior PAL MNone -
Registration 1: VENDT_613:X6509 014 -
Incoming Group 19
Outgeing Group 19
Max Calls per Channel 10 =
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SIP URI entry Channel 2 was similarly created for incoming calls appropriately to pre-define DID
numbers, which is provided by service provider, to access to Feature Name Extension 00 (FNEQO).
The Short Codes for FNEOO was defined in Section 5.5 to provide Dial Tone and Mobile Callback
for mobility extension.

The Channel 2, as shown in the screenshot below, was configured with following parameters.

e Via field is pre-populated by IP Office.

e Set the Local URI to pre-define DID number appropriately for Channel 2.

e Set Contact and Display Name to Internal Data. This setting allows calls on this line which
SIP URI matches the number set in the SIP tab of any User as shown in Section 5.6.

e PAI field is set to None.

e For Registration, select the account credentials previously configured on the line's SIP

Credentials tab.

e Associate Incoming Group and Outgoing Group to SIP Line 19.
e Set the Max Calls per Channel field to 10.
e Other parameters retain default values.
e Click OK.
IPOffices || Line ¥ SIP Line - Line 19 ef - X v
& BoOTP (9) Line Number |SIP LinelTransportI SIP URI IVoIP |T38 FaxlSIP CredentialslSIP AdvancedlEngineering|
=47 Operator (3) 1 - - -
2429 DevCon IPO 2 2 Channel Groups Via Local URI Contact Display Name PAI  Credential Add...
[ ~17 1 19 19 101098113 None 1: VEND7 613X
""" P 2 19 19 101098113 613XXX6516 Mone 1: VEND7_613X> lewrs
----- Contral Unit LA =
----- < Extension (42 Edit...
----- ﬁ User (44) "y, 20
..... “ Group (7) w21
----- BX Short Code (€
----- B senice ) | 2
..... Al RAS (1) 23
----- ) Incoming Ca | ™24
----- 8 WAN Port (0
----- @5 Directory (0)
£ 71 Time Profile |
----- {0 Firewall Profi Edit Ch |
----- B IP Route (2) o oK
..... am Account Cod Via 101098113
ey Local UR BL30E516 .
unnel (0}
a; User Rights (£ -
_____ @@ Auto Attend: Contact Use Internal Data
----- ¥ ARS (2) Display Mame Use Internal Data -
----- &5 Location (0)
----- m Authaorizatior PAI Mone -
Registration 1: VEND7_613XXX6509_014 -
Incoming Group 19
Outgeing Group 19
Max Calls per Channel 10 =
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ULAW 64Kand G.729(a) 8K CS-ACELP codecs cause IP Office to include
these codes, supported by the Bell Canada SIP Trunking service, in the Session Description
Protocol (SDP) offer, in that order.

e Set Fax Transport Support to G711 from the pull-down menu (T.38 faxing is not currently
supported by Bell Canada).

e Set the DTMF Support field to RFC2833 from the pull-down menu. This directs IP Office
to send DTMF tones using RTP events messages as defined in RFC2833.

e Uncheck the VoIP Silence Suppression box. By unchecking the VVolP Silence Suppression
box, calls can be established with the G.729 codec but without silence suppression.

e Check the Re-invite Supported box.
e Check the PRACK/100rel Supported box.
e Default values may be used for all other parameters.
e Click OK.
1P Offices | Ll. | ¥ SIP Line - Line 19° -8 X v
R ;‘ﬁ': "Jr'_ : ne ”“;: SP Lne Iun\poniw UR‘ ValP | 138 Fax ! SIP ('nanmuhiw Advanced | Engineenng
= Operator (3) | 1 I
i :.‘ l Vol Sdence Suppression ]
2 : -1} I ¢ Re-invite Supported l
> ;,,J,\"\m, :;::,Jj' ‘_ij:_ i r Codec Selection Cnlmum ] . % Codec Lockdown
i e {20 Usiused Seiected Allow Doect Media Path
WGoop® |wn G711 ALAW 64K G.711 ULAW 64K
#3 Shart Code (66| _ - G722 64K G.729(2) BK C5-ACELP
Sevice®) | GIBLEHIMP-MLQ ¥ PRACK/100rel Supported
& RAS(1 | -
@ Incoming Call | 28 G.711 Fax ECAN
@ WAN Port D)
#% Directory ()
Time Profile (0
@ Firewall Profile
B 1 Boute (2)
o™ Acco Codde
W License (42)
W Tunnel @) ~
‘. User Rights (B) Fax Trarsport Suppeet |G -
: iy DTMF Support RFC2833 -
; l[::'l':'c"’::d“",on ! Media Secunty Dwabled -
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details Pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “9N;” short code used in the test
configuration.

In the Code field, enter the dial string which will trigger this short code, followed by a semi-

[ ]
colon. In this case, 9N, this short code will be invoked when the user dials 9 followed by any
number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

e Others parameters are at default values.

e Click OK.

| IPOffices | ShortCode |7 N;: Dial" EREEIN
R soom -‘;-‘ Code Teley * [ Short Code
eI bl =

$X 163N tie‘u'r. Disl -
520 52N
Sty 54N Telephone Number N 2 ooccoooccer bell,ca

i Useriae W SSox  SEN RLine Group 1D 19 ¥
L LT N L

Locale -
78N Force Accoumt Code
0 “.‘;1.‘ s o ;l;N ]N': 3 Force Authonzation Code

4

Dwrectory [0) $XFNE0 00

Time Profile (0) - d = x
Firewall Profile (1) | « ' Lanced Help

QT;
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For incoming calls from mobility extension to FNE features hosted by IP Office to provide Dial
Tone functionality, Short Code FNEOO was created. The FNEOO was configured with the following

parameters.

¢ Inthe Code field, enter the FNE feature code as FNEOO for Dial Tone.
e Set the Feature field to FNE Service.

e Set the Telephone Number field to 00 for FNEOQO.
e Setthe Line Group ID field to 0.

e Retain default values for other fields.

e Click OK.
IP Offices | ShortC... || ¥ FNEOO: FNE Service* ef - X v =<
-~ & BOOTP (9) Code T *|l Short Code
# Operator (3) eSO
=% DevConIPQ 2 PSKN Code FNEOD
=) System (1)
Line {10} ;163N Feature FME Service -
= Control Unit (4) | #6520 5
,,,,, & Exension (42) 5400 5 Telephone Number 00
a User (44) B 5800 5t Line Group ID 0 -
X6 N
L Mo || Lol l -
----- e RAS (1) 7801 T Force Account Code [
""" g ‘If:f;DNmI;n?t((:;J” Ro ::;::02 N Force Authorization Code []
..... o . e
----- =m [Directory (0) B EMEDD Dt
-7 Time Profile (0) - = ] l C— ] [ =
----- ) Firewall Profile (1| « [ , = =ANce 0ep
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is “H323-29225”. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323-29225.
e The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from service provider.
e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.
e If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.
e Click OK.

IP Offices | User 7 Extn29225: 20225 ef - X v <>

-
& BOOTP (9) flame User | VYoicemail | DND | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In |‘u’oice Recording |
Operator (3) § Ean20223

Ly DevCon IPO 2 Personal Directory | Web Self-Administration|
Extn20224 |
5 System (1) [gﬁ Button Programming | Menu Programming | Mobility | Group Membership | Announcementsl SIP |
..... 7 Line (10) Extn20225 A
..... “o Control Unit (4) | - Extn20236 SIP Name 613XXX6500
----- ion42) #rExtn29227 _ _ 3
|: ..... § User(an) i En20233 SIP Display Mame (Alias) H323-29225
9% Short Cote (66) f-een2023t | 1| Contact 6136509
----- @ senice (0) i Exin20235
..... ol RAS (1) fExtn29236
----- @ Incoming Call Rout §Extn20237 I [C] Anonymaus -
""" £ WAN Port (0) frExtn29238 1 m b
..... @u Directory (0) &"E)¢ﬂ29239
-7 Time Profile (0) & o ocnman 34 |’ oK ll’ Cancel ] ’ Help
----- & Firewall Profile (1) [ ¢ I ’
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-29225.
e The Mobility Features and Mobile Twinning boxes are checked.
e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 916139675281
e Other options can be set according to customer requirements.

e Click OK.
IP Offices | User 7 Extn29225: 29225" e -8 X v <>
. ’! BOOTP (3) WL User Voicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In |Voice Recording |
Operator (3) a Extn29213
- DevCon IPO 2 a Extn20214 Web Self-Administration —_—
5 ET:ZE(T(]](D § Btn2021s Button Programming | Menu Programmingl Mability I Group Membership | Announcements | SIP | Personal Directory |
: Control Unit (4) a Extn29216 [T Internal Twinning
iy Extencion (4 § Ean20m17 <None>
& User(44) § Bdn20218
Uk Lrotp Extn20219 1
----- 9% Short Code (66) g Ean
..... B service (0) g Extn29220 1 Twin Bridge Appearances
..... ol RAS (1) Extn29221 Twin Cov . i
----- @ Incoming Call Route 1| § Extn20222 N -everagE Appearances
----- @ WAN Port (0) a Extn29223 Twin Line Appearances
----- == Directory (0)
1% Time Profile (0) | § Extn20225 Mobility Features
- " n.
----- & Firewall Profile (1) | Mobile Twinning
----- Bl 1P Route (2) n Twinned Mobile Numb
----- #m Account Code (0) | B Extn29227 (i:‘c'j‘u” dein d°ia|' :cc:;‘c:'de] 96139675281
----- % License (42) - Extn29233 d
----- @& Tunnel (0) - Extn29234 Twinning Time Profile <MNone>» -
-4 User Rights (8)
&8 Ao Anendant @ i Bxtn20235 Mobile Dial Delay (secs) 2
¢ ARS (2) § Exin29236 = _
_____ i Location (0) a"'EXtHEQEB? Mohile Answer Guard (secs) [0 =
""" % Authorization Code (( | f Extn29238 [T] Hunt group calls eligible for mobile twinning
g:zniziii [] Forwarded calls eligible for mobile twinning
n
ﬂHExtn}_‘gi‘*ll [] Twin When Logged Out
§ Exin20242 [] one-X Mobile Client
g:rvr{zgzzs Mobile Call Control
VR 29229
aHIVREQBO 7] Mobile Callback
§=1vR 20271 < = . .
§-1vR 20232 m
frNoUser -
< [ . ’ QK ] ’ Cancel ] ’ Help
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

e Click OK.
IP Offices | Incomi... || 19 613XXX6509 g -B X[ v<]>
-~ & BOOTP (9) Line GroupID ||| Standard |Voice Recording | Destinations|
+ Operator (3) @0 o
I, @1
""" T‘_ Eﬁte(;ﬂﬂ;lrl] @18 Bearer Capability ’Any Voice -
..... 1 Line
----- “= Control Unit (4) @19 Line Group ID 19 -
----- & Extension (42) [ T30
----- § Userag 19 Incoming Nurnber 613X0X6509
..... .ﬂ Group (7) o
..... % Short Code (66) 5 Incoming Sub Address
----- D Service () ) E
_____ S BAc 1) @10 Incoming CLI
I_ ----- Incoming Call Route (14) @20 Locale ’ ,]
----- WAN Port (0) @1
----- 2= Directory (0) Priori 1-L T
£ Time Profile (0) gg florty ’ ™ ]
----- @ Firewall Profile (1) Tag
----- Hll 1P Route (2) ®n
..... & Account Code (0) Hold Music Source ’System Source V]
----- e License (42) . ! N
_____ & Tunnel (0) Ring Tone Override one - il
----- §5 UserRights (8)
----- Wl Auto Attendant (0) I:l
..... ( ARS (2) 4 2

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 613XXX6509 on line 19 are routed to
extension 29225. Click OK.

IP Offices | Incomi... ||z 19 613XXX6509 ok -BIXIvi<l>
%% DevConIPO 2 Line Group . * | Standand | Voice Recording I Destinations | |
-5 System (1) o
..... 17 Line (10) 1 3 TimeProfile Destination Fallback Extension
----- o Sho¢ Code (66) Default Value [B?—E Extn29225 |v |[ |v|
----- @ Service (0] 19
19
D19 4 |:|
2

5.8. Save Configuration

Navigate to File - Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Bell Canada SIP Trunking Configuration

Bell Canada is responsible for the configuration of Bell Canada SIP Trunking service. The customer
will need to provide the IP address used to reach the IP Office at the enterprise. Bell Canada will
provide the customer the necessary information to configure the IP Office SIP connection to Bell
Canada. The provided information from Bell Canada includes:

e [P address of the Bell Canada SIP proxy.

e Supported codecs.

e DID numbers.

e [P addresses and port numbers used for signaling or media through any security devices.

7. Verification Steps

The following steps may be used to verify the configuration:
e Use IP Office System Status application to verify the state of the SIP connection. Launch the
application from Start - Programs - IP Office > System Status on the PC where IP
Office Manager was installed. Select the SIP line of interest from the left pane. On the Status
tab in the right pane, verify that the Current State is Idle for each channel (assuming no
active calls at present time).

IP Office System Status

Status  Utiization Summary Alarms  Registration

SIP Trunk Summary

Line Service State: In Service

Peer Domain Name: Vendor?.lab.internetvaice.ca
Resolved Address: 192,168.195.200
Line Number: 19

Number of Administered Channels: 20

Number of Channels in Use: 0

Administered Compression: G711 Mu, G729 A
Enable Faststart: Off

Silence Suppression: off

Media Stream: RTP

Layer 4 Protocol: UDP

SIP Trunk Channel Licenses: Unlimited . 0o
o
SIP Trunk Channel Licenses in Use: 0

SIP Device Features:

ent Timein Re = Co... Conne... Caller ID Other Party on D L0 1= leceive  Transmit Transmit

e State A or Dial... Call of ip D... Jitte Lo Jitter Packe...

le [1day... -
Idle |1day...
Idle |1day...
Idle |1day...
Idle |iday... =

s | Lo |

Trace Trace Al H Pause H Ping ] Call Details Graceful Shutdown H Force Qut of Service H Print... H Save As...
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Status  Utilization Summary Alarms Registration

Alarms for Line: 19 SIP Vendor7.lab.internebooo.ca

Last Date Of Error Occurrences Error Description

» D

Line:20

Clear Clear all Graceful Shutdown ] [ Force Out of Service Print... Save As...

5:11:31PM

e Verify that a phone connected to PSTN can successfully place a call to IP Office with two-
way audio.

e Verify that a phone connected to IP Office can successfully place a call to the PSTN with
two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signalling between the
enterprise and Bell. The sniffer traces are captured at the public interface of IP Office.

8. Conclusion

The Bell Canada SIP Trunking passed compliance testing with all observations noted in Section 2.2.
These Application Notes describe the procedures required to configure the SIP connection between
Avaya IP Office 500 V2 R9.1 and the Bell Canada SIP Trunking service as shown in Figure 1.
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[4] 1P Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-604067,
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[5] Avaya IP Office™ Platform Release 9.1, Product Update Document (Offer Definition), Update
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Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Bell Canada SIP Trunking is available from Bell Canada.
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